
 

 

 

Quadcopter Tutorial 

Rapid Adoption Kit (RAK) 

 

Product Version: Pointwise 18.5 R1 
January 2022



 
 

Learn more at Cadence Learning and Support Portal - https://support.cadence.com 

© 2022 Cadence Design Systems, Inc. All rights reserved worldwide. Page 2 

 

Copyright Statement 

© 2022 Cadence Design Systems, Inc. All rights reserved worldwide. Cadence and the Cadence logo are 

registered trademarks of Cadence Design Systems, Inc. All others are the property of their respective 

holders.



Double-click here to add header (Example: Implementing MIPI Constraints: RAK) 

Learn more at Cadence Learning and Support Portal - https://support.cadence.com 

© 2022 Cadence Design Systems, Inc. All rights reserved worldwide. Page 3 

 

Contents 

Purpose ....................................................................................................................... 4 
Audience ...................................................................................................................... 4 

Terms .......................................................................................................................... 4 
Overview ...................................................................................................................... 4 

Geometry ..................................................................................................................... 4 
Topology ...................................................................................................................... 5 
Database Import .......................................................................................................... 5 
CAE Selection ............................................................................................................. 5 

Surface Mesh Creation ................................................................................................ 6 
Surface Mesh Edit ....................................................................................................... 8 
Surface Mesh Examination ........................................................................................ 10 

Volume Mesh Creation .............................................................................................. 10 
Volume Mesh Smoothing ........................................................................................... 13 

Set CAE Boundary Conditions ................................................................................... 14 
Save Project .............................................................................................................. 15 
CAE Export ................................................................................................................ 15 

Support ...................................................................................................................... 15 

Feedback ................................................................................................................... 15 
 



Double-click here to add header (Example: Implementing MIPI Constraints: RAK) 

Learn more at Cadence Learning and Support Portal - https://support.cadence.com 

© 2022 Cadence Design Systems, Inc. All rights reserved worldwide. Page 4 

 

Purpose 

This purpose of this RAK is to guide you through the basic process of creating a surface 
grid and volume grid using the available automated tools: Automatic Surface Mesh and 
Automatic Volume Mesh. This RAK is solely intended to show the basic usage of these 
tools and is not designed to provide a thorough description of all the available options 
and parameters. 

Audience  

This document is intended for Pointwise users who wish to use the automated tools 
available to effortlessly create surface and volume grids. 

Terms 

CFD  Computational Fluid Dynamics 

CAE   Computer-aided Engineering 

Overview 

This tutorial contains a brief overview of the operations necessary to set up an 
unstructured surface mesh and viscous volume mesh about a quadcopter geometry 
using our automated tools: Automatic Surface Mesh and Automatic Volume Mesh. This 
exercise will help you to become familiar with Pointwise’s flexible and powerful 
approach to automated grid generation. 

Geometry 

The geometry to be meshed is one half of a simplified quadcopter. Since this tutorial will 
focus on the steps necessary to create a high-quality viscous unstructured volume 
mesh, you will use a geometry that has already been cleaned up by removing gaps and 
overlaps and assembled into a single watertight database model with appropriate 
meshing regions (i.e. database quilts). 

 

Figure 1: The half quadcopter geometry that will be used in this tutorial. 

https://www.pointwise.com/doc/user-manual/create/automatic-surface-mesh/index.html
https://www.pointwise.com/doc/user-manual/create/automatic-volume-mesh/index.html
https://www.pointwise.com/doc/user-manual/create/automatic-surface-mesh/index.html
https://www.pointwise.com/doc/user-manual/create/automatic-volume-mesh/index.html
https://www.pointwise.com/doc/user-manual/create/assemble/models.html
https://www.pointwise.com/doc/user-manual/create/assemble/quilts.html
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Topology 
The topology will consist of unstructured hybrid surface domains that describe the 
center-body, the arms, the simplified motors, and the propellers of the quadcopter.  
Additional hybrid unstructured domains will be created to represent the farfield used to 
assemble the final voxel block. 

 

 
Figure 2: The final topology of the viscous mesh to be constructed. The surface grid is shown on the left side and the 

volume grid is shown on the right side. 

Database Import 

The initial file used in this tutorial can be downloaded from this page. You may want to 
save this file to a local directory before using it.  
The geometry you will use in this example is a Pointwise project file named  
quadcopter-ASM-AVM-Initial.pw. 
 

1. Select the File menu option  (upper side of the Pointwise interface). 
2. Select Open (second from the pull-down list). 
3. Select quadcopter-ASM-AVM-Initial.pw from the file browser. 
4. Open 

 
You should now have a representation of the geometry in your Display window similar 
to Figure 1 on the previous page.  

CAE Selection 

Before starting a meshing project, it is always a good idea to first set the grid dimension 
and CAE solver. This helps avoid any situations in which you create a mesh type that is 
unsupported by your solver. 
 

1. Note in the Status Bar that the current CAE solver is CGNS and the current 
dimension is 3D. 

2. CAE, Select Solver 
3. OMNIS 
4. OK 

https://www.pointwise.com/doc/user-manual/getting-started/terminology.html
https://www.pointwise.com/doc/user-manual/grid/solve/voxel-blocks/index.html
https://www.pointwise.com/doc/user-manual/gui/pointwise-interface/index.html
https://www.pointwise.com/doc/user-manual/gui/pointwise-interface/status-bar.html
https://www.numeca.com/omnis
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You should see the name of your currently selected CAE solver, OMNIS, appear in the 
left-hand corner of the Pointwise status bar. 

Surface Mesh Creation 

Pointwise offers a wealth of tools to create surface meshes (Review the Pointwise User 
Manual for details). These are all fantastic tools providing ever more control, 
convenience, and robust meshing. However, using al these tools independently to 
create a wonderful set of surface grids can take some time and experience with the 
software and our recommended best-practices for different cases.  
The Automatic Surface Mesh tool offers a target driven approach to surface grid 
generation that encapsulates all our recommended best practices for any case you 
might be working on. Additionally, the starting point to use this automated tool is a 
watertight database model with well-defined meshing regions (i.e. database quilts). 
 

1. Select the Database model named quadcopter. 
2. Select the Create menu option (upper side of the Pointwise interface). 
3. Select Automatic Surface Mesh (first option in the pull-down list). 

For a detailed description of all the options available in this functionality, please review this section of the 
Pointwise User Manual. 

4. Make sure the Global tab is currently selected. 
This panel presents the geometric characteristics of the selected database models. It also contains tools to define 
the meshing resolution goals, its quality constraints, and some additional advanced parameters to control the 
characteristics of the resulting surface mesh. 

5. In the Goals frame, enter 20.0 for Max. Aspect Ratio. 
The Max. Aspect Ratio parameter limits the maximum aspect ratio allowed for the anisotropic cells created by the 
T-Rex algorithm along the 2D T-Rex boundaries. In this particular case, we increase this parameter from its 
default value of 10.0 to reduce the number of grid points along the spanwise direction of the propeller blades. 

6. Select the Surfaces tab. 
This panel contains tools for adjusting the display style within the Automatic Surface Mesh command and for 
specifying Resolution and Mapping filters, which allow you to assign specific target edge lengths for each quilt 
and specify which quilts receive a mapped meshing treatment (i.e. the resultant unstructured domains are mapped 
to and retain the appearance of underlying structured domains). 

7. In the Mapping frame (i.e. lower table), click New. 
In this particular case, we will use the tools in this frame to create a new mapping filter to force the number of grid 
points across the blades’ trailing edges to a user-specified specified value. 

8. Double click filter-1 in the Name column. 
9. Enter TEs (for Trailing Edges). 
10. In the Pattern column enter *TE*. 

Specifying a pattern will allow you to quickly assign all database quilts with names matching the specified pattern 
to a new mapping filter. In this particular case, the four trailing edge quilts on both blades are named: Prop-TE-1, 
Prop-TE-2, Prop-TE-3, and Prop-TE-4; they all match the pattern *TE*.  

11. Note that the four trailing edge database quits for the blades have been added to 
the new filter.  

12. Note the following in the new mapping filter: 
a. The database quilts added to the new filter are rendered in a unique color matching the 

color shown in the Set column in the new row. 
b. The number of added database quilts is shown in the # column in the new row. 

13. Double click Automatic in the Type column. 

https://www.pointwise.com/doc/user-manual/index.html
https://www.pointwise.com/doc/user-manual/index.html
https://www.pointwise.com/doc/user-manual/create/automatic-surface-mesh/index.html
https://www.pointwise.com/doc/user-manual/create/assemble/quilts.html
https://www.pointwise.com/doc/user-manual/gui/pointwise-interface/index.html
https://www.pointwise.com/doc/user-manual/create/automatic-surface-mesh/index.html
https://www.pointwise.com/doc/user-manual/grid/solve/unstructured-domains/t-rex.html
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14. Select Force from the pull-down list. 
15. Enter 5 in the Subdivisions column. 
16. Select the Boundaries tab. 
17. Note that the different edge types (i.e. Curvature, Convex, and Concave) are 

rendered in a unique color in the table and the Display window. 
18. In the Convex row in the table, double click the Max. Aspect Ratio. 
19. Select the Off option from the pull-down list. 

This effectively turns off stretching of the surface cells coming off of the convex edges in the geometry. 

20. Select the Global tab. 
21. Click Generate Surface Mesh. 
 
The new surface grid should look similar to the one shown in Figure 3.  

 
 

Figure 3: Surface grid created by the Automatic Surface Mesh functionality. On the left side, we show a general 
overview of the entire surface mesh. On the right side, we show a closeup view of the surface grid around one of the 
quadcopter’s motors. 

Before exiting the Automatic Surface Mesh functionality, please review the quality 
metrics presented in the Global tab. 
 

22. Make sure the Global tab is currently selected. 
23. Note the table in the Display frame at the very end of the panel. 
24. Note that there are surface cells that violate the Area Ratio threshold set to 10. 

Also note that the Max. Value is only slightly above the defined threshold. 
25. Check on the Show option in the Area Ratio row.  
26. Note that the surface cells violating the defined Area Ratio threshold are 

rendered in red. Also note that these cells are located on the blades’ trailing 
edges (Figure 4). 

 

  
Figure 4: Surface cells violating the defined Area Ratio threshold. On the right side we present a closeup of these 
cells located in the trailing edge region of the four blades in the geometry. 

https://www.pointwise.com/doc/user-manual/examine/functions/area-volume-ratio.html
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Even though the created surface mesh is of good quality and could certainly be used for 
a CFD simulation, in the next section we will review how to resolve the Area Ratio 
problem shown above. 
 

27. Click OK.  
This will exit the Automatic Surface Mesh functionality and save your new surface mesh. 

 

Surface Mesh Edit 

One of the beautiful things of the Automatic Surface Mesh (in addition to creating your 
surface mesh with minimum effort) is that it allows you to edit your final surface grid if 
needed using the wealth of tools available in Pointwise.  
In this section, we will edit the generated surface grid and add cell stretching (i.e. 
anisotropic cells) on the blade surfaces near the trailing edges. This will resolve the 
Area Ratio problem described at the end of the previous section (Figure 4). 
Let us start by changing the display settings of the database and domain entities to 
better visualize the new surface grid. 
 

1. Select the View menu option (upper side of the Pointwise interface). 
2. Select Show Database from the pull-down list. 

This effectively turns off the display of database entities to reduce clutter in the Display window. 

3. Select the List tab. 
4. Click the Domains label on the list. 

This selects all the domains in your mesh. You should see the domains highlighted in white in the Display window. 
If your domains are not selected, please check that your Domains selection mask is turned on. 

5. Select the View menu option (upper side of the Pointwise interface). 
6. Select Attributes from the pull-down list. 
7. In the Display frame, select the fourth Fill option: Hidden line ( ). 

Note that this display option is also available in the Attributes toolbar for easy access. 

8. Click Update Entity Display. 
9. Close 

 
Now that the Display window is free from clutter and we have a nice view of the surface 
grid, let us add stretching to the blade domains near the trailing edges. 
 

1. Zoom close to one of the quadcopter blades. 
2. Note that, among others, you have an upper and lower surface domain. 
3. Place your mouse pointer over the upper surface domains and click the left 

mouse button.  
Placing your mouse pointer over the surface domain should cause it to be rendered in a salmon color. Once 
highlighted, clicking the left mouse button effectively selects the upper domain. 

4. Tap the Space bar and note that the lower surface domain will be highlighted in 
salmon color as well. 
Tapping the Space bar allows Pointwise to loop over all the entities that could be selected. This is based on the 
current state of the selection masks and the current position of the mouse pointer.  

https://www.pointwise.com/doc/user-manual/gui/pointwise-interface/index.html
https://www.pointwise.com/doc/user-manual/gui/pointwise-interface/panels/list.html
https://www.pointwise.com/doc/user-manual/gui/interaction/selection-methods.html
https://www.pointwise.com/doc/user-manual/gui/pointwise-interface/index.html
https://www.pointwise.com/doc/user-manual/gui/interaction/selection-methods.html
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5. Press and hold the Control key. 
This enables the selection of multiple entities. 

6. Select the lower surface domain for the same blade. 
At this point, you should have the upper and lower surface domains selected. 

7. Repeat Steps 1 thorough 5 and select the upper and lower surface domains of 
the other three blades. 
At this point, you should have eight surface domains selected. Two on each blade. 

8. Select the Grid menu option (upper side of the Pointwise interface). 
9. Select the Solve option from the pull-down list. 
10. Select the Boundary Conditions tab. 

In this panel, you will find all the needed tools to define the desired T-Rex boundary conditions.  

11. Click New to create a new T-Rex boundary condition. 
12. Double click bc-3 in the Name column. 
13. Enter TEs and press Enter. 
14. Double click Off in the Type column. 
15. Select Adjacent Grid from the pull-down list. 
16. Zoom in close to the trailing edge of one of the blades. 
17. Place the mouse pointer over the edges connecting the trailing edge domain and 

the upper surface domain. 
18. Click the left mouse button to select the edge. 
19. Place the mouse pointer over the edges connecting the trailing edge domain and 

the lower surface domain. 
20. Press and hold the Control key. 

This enables the selection of multiple entities. 

21. Click the left mouse button to select the edge. 
At this point you should have both edges on the blade selected. 

22. Repeat Steps 16 through 21 and select the same edges on the other three 
blades. 
At this point you should have eight edges selected. Two on each blade. 

23. Click the Set checkbox in the new row in the Boundary Conditions table. 
24. Note that the number of edges in the new boundary condition (8) is indicated in 

the # column.  
25. Select the Solve tab. 
26. Click Refine. 

This refines the selected surface domains (i.e. upper and lower domains on each blade) and applies the new T-
Rex boundary condition. 

27. Click OK. 
This closes the Boundary Conditions panel and saves your changes. 

 
Your surface grid should look similar to what is shown in Figure 5. In this image, we 
show a clear comparison of the upper domain on one of the blades before and after 
stretching was applied. 

https://www.pointwise.com/doc/user-manual/gui/pointwise-interface/index.html
https://www.pointwise.com/doc/user-manual/grid/solve/unstructured-domains/boundary-conditions.html
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Figure 5: Stretching applied to the upper and lower surface domains of each balde in the trailing edge region. On the 
left side, we show one of these domains without stretching. On the right side we show the same domain with 
stretching. 

Surface Mesh Examination 
In order to make sure our changes to the surface grid generated using the Automatic 
Surface Mesh functionality resolved the Area Ratio issue shown in Figure 4, let us use 
the tools available in the Examine functionality to check the quality of the final surface 
mesh.  
 

1. As done before, select all the surface domains. 
2. Select the Examine menu option.  
3. Select the Area Ratio metric from the pull-down list. 
4. Note in the color bar that the maximum value of the Area Ratio in now around 3. 

This is certainly below the defined threshold value for this metric (i.e. 10).  
5. At this point, we would recommend you review the available options in the 

Examine functionality to become familiar with it. For additional information, 
please review this section of the Pointwise User Manual. 

6. Click Close. 

Volume Mesh Creation 

Now that the surface mesh is complete and examined, we are ready to create the 
volume grid. To this end, we will use the Automatic Volume Mesh functionality which will 
allow you to quickly assemble a farfield block in an automated manner and with 
minimum effort. 
 

1. Select all the surface domains. 
2. Select the Create menu option. 
3. Select the Automatic Volume Mesh option from the pull-down list. 
4. Select the Create Volume Mesh Boundaries option.  

This option automatically defines symmetry planes and farfield extents for external volume grids. 

https://www.pointwise.com/doc/user-manual/examine/functions/area-volume-ratio.html
https://www.pointwise.com/doc/user-manual/index.html
https://www.pointwise.com/doc/user-manual/index.html
https://www.pointwise.com/doc/user-manual/create/automatic-volume-mesh/index.html
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5. Make sure the Global tab is currently selected. 
6. Select the following options: 

a. Type: Voxel (i.e. second option) 
The new volume grid will be of Voxel type. 

b. Shape: Box (i.e. first option) 
The farfield block will have a box shape. 

c. Center: Margins (i.e. first option) 
The extents of the box farfield will be computed relative to the faces of the extents box of the surface 

grid. 

7. Specify the following margins to define the size of the farfield block: 
a. L1: 500  

Note that L2 will be set to the same value automatically. 

b. W1: 300 
c. H1: 500 

Note that H2 will be set to the same value automatically. 

 
Once the above parameters are specified, the geometrical shape and size of the farfield 
block should look similar to Figure 6. 

 
Figure 6: The specified parameters define the geometrical shape and size of the farfield block. 

Since we are interested in creating a viscous volume grid, we will need to add 
anisotropic cells in the boundary layer region (i.e. volume cell stretching). 
 

8. Select Geometric Growth from the Boundary Layer pull-down list. 
9. Enter 0. 001 in the Wall Normal Spacing entry field. 
10. Select the Boundary Conditions tab. 
11. Note that the needed T-Rex boundary conditions have been defined 

automatically. 
12. Select the Advanced tab. 
13. Under Symmetry Planes, note that a +X symmetry has been automatically 

recognized. 
14. Also note that the symmetry edge on the surface grid is rendered green (Figure 

7). 

https://www.pointwise.com/doc/user-manual/grid/solve/unstructured-blocks/boundary-conditions.html
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Figure 7: The symmetry edge in the surface grid is automatically recognized and rendered in green for easy 

visualization. 

15. Select the Global tab. 
16. Click Create Volume Mesh. 

 
The new volume grid has been created. However, note that at this point the new block 
is empty (i.e. it doesn’t have interior cells).  
 

17. Check on the Populate Volume Mesh on Command Completion checkbox. 
This will ensure that the new volume grid gets initialized (i.e. populated with cells) as soon as you click the OK 
button to exit the Automatic Volume Mesh functionality. 

18. Click OK. 
This exits the Automatic Volume Mesh functionality and saves your changes. Note that, as mentioned in Step 17 
above, the volume grid will be initialized as soon as this functionality exits. The initialization process can take a 
couple of minutes depending on your machine. 

 
The new volume grid should look similar to the one shown in Figure 8. 

 
Figure 8: Final voxel volume grid assembled using the Automatic Volume Mesh functionality with minimum input from 

the user. 
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Volume Mesh Smoothing 
Note that an extrema value of ~175 degrees for the Maximum Included Angle examine 
function (shown above) is suitable for most commercial CFD solvers. That being said, if 
your solver has more restrictive requirements, you can use the Smoothing tool provided 
by the unstructured solver to smooth the volume mesh and reduce the obtained 
extrema value. 
 

1. Select the block. 
2. Select the Grid menu option. 
3. Select the Solve option from the pull-down list. 
4. Select the Attributes tab. 
5. Check on the Smoothing checkbox. 
6. Enter 170.0 in the Cost Angle Threshold entry field.  

The Cost Angle is an alternate form of the Maximum Included Angle (Smoothing section of the Pointwise User 
Manal). This parameter set the angle to determine which volume cells in the mesh should receive smoothing. 

7. Select the Solve tab. 
8. Enter 100 in the Iterations entry field.  

This parameter specifies the desired number of smoothing iterations. 

9. Click Smooth. 
This starts the Weighted Condition Number smoother which will look to smooth the volume cells with a Cost Angle 
larger than the value specified in Step 6 and will run the number of iterations specified in Step 8.  

 
It is important to note that the Examine functionality used previously can be accessed 
directly from the unstructured solver panel.  
 

10. Select the Max. Included Angle option from the Functions pull-down list. 
11. Click Examine. 
12. In the Extrema frame, note the extrema value for the Maximum Included Angle 

function. The value should have decreased considerably from its initial value 
close to 175 degrees.  

13. Click Close. 
This closes the Examine functionality and puts you back in the Unstructured solver panel.  

 
If the final grid is appropriate for your CAE solver, you can simply click OK. However, if 
you would like to further smooth your grid, you can simply run another pass of the 
Weighted Condition Number smoother.  
 

14. Click OK. 
This closes the unstructured solver panel and saves your changes. 

 
 

https://www.pointwise.com/doc/user-manual/grid/solve/unstructured-blocks/solve.html
https://www.pointwise.com/doc/user-manual/grid/solve/unstructured-blocks/attributes-tab/smoothing.html
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Set CAE Boundary Conditions 
Prior to exporting your finished grid, set up the boundary conditions that you plan to use 
in the currently selected CAE solver (OMNIS in this case). Setting these boundary 
conditions now will make it easier for you to identify regions in your grid once it is 
imported into your solver. 
 

1. Select the CAE menu option. 
2. Select the Set Boundary Conditions option from the pull-down list. 
3. Click New. 

This creates a new CAE boundary condition. 

4. Double-click the Name field of the new boundary condition (bc-2). 
5. Enter Farfield. 
6. Double-click the CAE Type field of the Farfield boundary condition. 
7. Select Farfield. 
8. Select the five domains defining the farfield box (do not select the symmetry 

domain). 
9. Check the Farfield boundary condition.  

This assigns the selected domains to Farfield boundary condition. 

10. Click New. 
11. Double-click the Name field of the new boundary condition (bc-3). 
12. Enter Quadcopter. 
13. Double-click the CAE Type field of the Quadcopter boundary condition. 
14. Select Wall Viscous. 
15. Select all the surface domains on the quadcopter. 
16. Check the Quadcopter boundary condition.  

This assigns the selected domains to Quadcopter boundary condition. 

17. Click New. 
18. Double-click the Name field of the new boundary condition (bc-4). 
19. Enter Symmetry. 
20. Double-click the CAE Type field of the Symmetry boundary condition. 
21. Select Symmetry Plane. 
22. Select the symmetry domain. 
23. Check the Symmetry boundary condition.  

This assigns the selected domain to Symmetry boundary condition. 

24. Click Close. 
This closes the CAE Boundary Conditions panel and saves your changes. 

You have now assigned domains to boundary conditions for export to OMNIS. 

 

 

https://www.pointwise.com/doc/user-manual/file/export/cae/index.html
https://www.pointwise.com/doc/user-manual/cae/set-boundary-conditions/index.html
https://www.numeca.com/omnis
https://www.numeca.com/omnis
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Save Project 
Save your final mesh to your project file now so you can easily access your mesh in 
Pointwise while retaining all previously used layer and display settings. 
 

1. Select the File menu option. 
2. Select the Save As option from the pull-down list. 
3. Navigate to your preferred save folder. 
4. Enter quadcopter-ASM-Final.pw in the File name field. 
5. Click Save. 

CAE Export 

You can now export your mesh to OMNIS and start generating solutions for your 
application. 
 

1. Select the block 
2. Select the File menu option. 
3. Select the Export option from the pull-down list. 
4. Select the CAE option from the secondary pull-down list.  
5. Specify a filename. 
6. Click Save. 
7. Click OK. 

Support 

Cadence Learning and Support Portal provides access to support resources, including 
an extensive knowledge base, access to software updates for Cadence products, and 
the ability to interact with Cadence Customer Support. Visit 
https://support.cadence.com. 

Feedback 

Email comments, questions, and suggestions to content_feedback@cadence.com. 

https://www.numeca.com/omnis
https://support.cadence.com/
mailto:content_feedback@cadence.com

